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PPaacckkaaggee  CCoonntteennttss  

 

Contents of Package 

 D-Link DUB-AV300 USB 2.0 MPEG 1/2/4 Video Grabber 
 USB 2.0 Cable  
 AV Cable 
 CD-ROM(containing Drivers, Installation Guide, Manual, Application Software and 

Warranty 
 D-Link Quick Installation Guide 

 

If any of the above items are missing, please contact your reseller. 
 

System Requirements 

 Pentium IV 2GHz or Above 
 Microsoft Windows 2000 SP4/XP 
 256MB RAM or higher 
 2X CD-ROM 
 16bit or higher level Sound-Card 
 One Available USB Port (USB 2.0 ) 
 PCI/AGP 32 Bit VGA card or higher & Monitor 

 

Introduction 

The D-Link DUB-AV300 is an advanced video-capture and display device which provides 
you with a “high quality PC Theater” solution. The D-Link DUB-AV300 allows you to 
capture 30 frames per second (fps) while giving you up to 720x480 resolution for a high 
quality video image on a PC or notebook using USB2.0. The DUB-AV300 captures CD 
quality stereo audio with a 16 bit, 48/44.1KHz sampling rate and provides audio/video 
synchronization.  
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With the user-friendly program, WinDVD Creator 2.0, you can easily transfer the captured 
audio/video bit stream into other standard formats such as AVI, MPEG4, VCD and DVD. 

Please read the information below which is aimed to assist you in using the WinDVD 

Creator 2.0 software with your DUB-AV300 Video Grabber. 
 

Getting To Know Your USB 2.0 MPEG 1/2/4 Video Grabber 

 

 
 

Features and Benefits 

 Analog to Digital Video Convert 
 720 x 480 (NTSC) @ 30fps High Quality Resolution 
 720 x 576 (PAL) @ 25fps High Quality Video 
 Audio Capture & A/V Synchronization Function 
 Saturation/Contrast/Hue/Brightness Adjustment 
 Create MPEG1/2/4 Movies 
 Direct Burn-to-Disc of Recorded MPEG1 /2/4 with CD/DVD Burner 
 Video Editing Software Include 

 
In the following pages, you will be guided through the operation of the Application, WinDVD 
Creator 2  

The contents are divided into 4 parts, 1. InterVideo’s WinDVD Creator 2  
2. Main Window 
3. Basic Tasks 
4. Making a Movie 
 
 
 
 

USB connector 

S-Video Jack 

Composite 

Video Jacks
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1. InterVideo's WinDVD Creator 2 

 

Welcome to WinDVD Creator 2. This InterVideo application lets you combine 
your personal video, digital images, and audio into exciting, professional-quality 
movies. Whether you are editing your first movie or looking for a program that will 
let you take your productions to the next level, WinDVD Creator's straightforward 
drag-and-drop editing style combined with its comprehensive editing capabilities will 
meet your needs today and tomorrow. 

 

With WinDVD Creator 2, you can: 

• Import video, image, and audio files in a wide variety of popular formats 
including: MPEG1, MPEG2, AVI, BMP, JPEG, MP3, and WAV. 

• Use simple drag-and-drop operations to turn the clips into a compelling DVD. 

• Enhance your movie with professional-quality special effects. 

• Perform DVD-authoring tasks.  

• Save your finished movie in a VCD, SVCD, DVD, or VR format.  

Note: Not all listed features are available in select versions of WinDVD Creator 2. 
Some applications such as Media Player can not play VCD or SVCD. You can use 
WinDVD or a similar player to play it.  

 
Related Topics 
Video Source Requirements 
WinDVD Creator's Specifications 
WinDVD Creator's System Requirements 
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2. Main Window 

The following figure identifies the elements of WinDVD Creator's main window. 
For details on a particular element, click it in the figure.  

In WinDVD Creator 2, making a movie involves the following processes: capturing 
content, editing, DVD-authoring, and saving your output. The appearance of 
WinDVD Creator's main window is different during each process. The following 
figure is an example of WinDVD Creator's interface during the editing process.  

 

 

3. Basic Tasks 

To make a movie, you will usually do the following: 

1. Create a new project to organize your work. 

2. Capture the video, image, and audio content that is to be the basis of your movie. 
You do so by either recording content with WinDVD Creator 2, WinProducer 2, or 
a similar application, and importing files created with WinProducer 2, WinCoder, 
or another application. 

3. Break up video clips into smaller sections, called scenes. 

4. Assemble the clips in the desired sequence in either the Story Board or Time 
Line. 

5. Add special effects such as transition effects and titles. 
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6. Perform DVD-authoring tasks. 

7. Save your movie. 

8. Direct record to disc. 

 

3.1 Creating Projects 

Create a WinDVD Creator 2 project so you can organize your work. A project 
includes information about the media clips you add, your edits, and your final movie. 
Because WinDVD Creator 2 lets you save your work to a project, you can exit 
WinDVD Creator 2 and then later resume working on a movie without losing your 
changes. 

To create a new project: 

1. Do one of the following: 

• In the Toolbar, click  

• From the Project menu, choose New Project. 

2. If you are prompted to save a project that is currently open, save it by clicking Yes. 

 

WinDVD Creator 2 will prompt you to save a project only if there are unsaved 
changes in an open project. Otherwise, WinDVD Creator 2 automatically closes an 
open project before creating a new one. 

 
Related Topics 
Opening a Project 
Saving Projects 

 

3.2 Importing Files 

You can import video, audio, or image files created in WinProducer 2, WinCoder, 
or a similar application. The files you import can be located on your computer or 
another computer connected to your network. WinDVD Creator 2 adds imported files 
as clips to the Media Libraries. For example, video clips are added to the Video 
Library and image clips are added to the Image Library. 

Import files using any of the following: 

• 3.2.a Drag-and-drop feature  

• 3.2.b Media Files command 
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• 3.2.c Import button 

Notes:  

• WinDVD Creator 2 automatically imports the files it creates while capturing 
still images or recording video or audio. Therefore, you do not have to import 
such files. 

• Imported files are represented in the libraries as clips. While making a movie, 
you work with the clips rather than the original source files. 

• The audio and video portions of a video file are imported as a single video clip 
to keep the audio and video synchronized. 

WinDVD Creator 2 supports Windows compatible file as long as corresponding 
codec is installed in system. Divx is one of popular Windows compatible codec. Once 
DivX is installed on to the system, WinDVD Creator 2 could import DivX file. 
 
Related Topic 
What Can You Capture? 

 

3.2.a Importing with Drag-and-Drop Feature 

To import using the drag-and-drop feature: 

 
 
 
Notes: 

• WinDVD Creator 2 adds the imported files as clips to the appropriate library. 
For example, video clips are added to the Video Library and image clips are 
added to the Image Library. 

• The clips in the Media Libraries represent imported files. While making a 
movie, you work with the clips rather than the original source files. 

• The audio and video portions of a video file are imported as a single video clip 
to keep the audio and video synchronized. 
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Related Topics 
Importing with a Command 
Importing with the Import Button 
What Can You Capture? 

 

3.2.b. Importing with the Media Files Command 

To import using the Media Files Command: 

1. From the Import menu, choose Media Files. The Import Media File dialog 
box appears. 

2. Browse to locate the files you want to import.  

3. Select the desired files.  To select multiple files, press Ctrl+Click or 
Shift+Click. You may import any combination of video, image, and audio 
files.  

4. Click Open.  If you are importing only one file, you may double-click the 
file name instead of clicking Open. 

 

Notes: 

• WinDVD Creator 2 adds the imported files as clips to the appropriate Media 
Library. For example, video clips are added to the Video Library and image 
clips are added to the Image Library. 

• The clips in the Media Libraries represent imported files. While making a 
movie, you work with the clips rather than the original source files. 

• The audio and video portions of a video file are imported as a single video clip 
to keep the audio and video synchronized. 

 
Related Topics 
Dragging to Import Files 
Importing with the Import Button 
What Can You Capture? 
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3.2.c. Importing with Import Button 

To import using the Import button: 

1. Do one of the following: 

• Click . Then click  in the Storage pane. 

• Click . Then click  in the Editing pane. 

The Import Media File dialog box appears. 

2. Browse to locate the files to import.  

3. Select the desired files. To select multiple files, press Ctrl+Click or Shift+Click, 
you may import any combination of video, image, and audio files.  

4. Click Open.  If you are importing only one file, you may double-click the file 
name instead of clicking Open. 

 

Notes: 

• The Import button is available only while you are capturing content or editing. 
It is not available when you are authoring or saving output. 

• WinDVD Creator 2 adds the imported files as clips to the appropriate Media 
Library. For example, video clips are added to the Video Library and image 
clips are added to the Image Library. 

• The clips in the Media Libraries represent imported files. While making a 
movie, you work with the clips rather than the original source files. 

• The audio and video portions of a video file are imported as a single video clip 
to keep the audio and video synchronized. 

 
Related Topics 
Dragging to Import Files 
Importing with a Command 
What Can You Capture? 
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3.3 Breaking Up Video Clips 

Sometimes the video clips you record or import are too long to work with easily. 
For example, you might have captured 10 or 20 minutes of video from your camcorder 
into a single file. This would be much easier to work with if it were broken into smaller 
clips based on the natural scene breaks in the video. WinDVD Creator 2 can 
automatically create these scenes for you, saving a lot of time in the editing process. 

To automatically break up a video clip into smaller scenes: 

 
 

1.Click   

2. If necessary, open the Video Library by clicking  in the Editing pane. 

3. In the Video Library, right-click the video clip you want to break up. You may need     
to scroll up or down in the Editing pane or resize it before the desired clip comes into 
view. 

4. Do one of the following: From the shortcut menu that appears, choose Show Video 
Scenes. 

5. Select either Auto Detect or By Time.  

• Choosing Auto Detect, you must set the Sensitivity at which it separates the 
scenes by. For example, the light factor between scenes or details of each image. 
From 1 being the lowest to 100 being the highest. 

• Choosing By Time will separate scenes into each clip depending on the time 
you set it too. 

6.Click  in the Editing pane. 
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• WinDVD Creator 2 scans the video clip, looking for changes in the image from 
frame-to-frame. If it finds a significant change, which is common where the camera 
stopped and started, it breaks the clip into smaller clips (also called scenes) at the 
point.  

• WinDVD Creator 2 creates a new set of video clips in the Video Library. These 
clips are ordered from the start to the end of the original video clip. For example, 
WinDVD Creator 2 might break up a video clip into five scenes as shown in the figure 
on the left.  

• No new files are created on the disk when you generate scene cuts. You may add 
any of generated scenes to your movie as you would any other clip. 

• You do not have to delete any unused scenes because WinDVD Creator 2 
automatically eliminates the generated scenes when you perform an action that causes 
WinDVD Creator 2 to leave the Video Library. If you want to later work with the scenes 
again, simply break up the clip again. 

 

3.4 WinDVD Creator's Story Board 

  As the name implies, the Story Board tells a story. You may use the Story Board to 
arrange your movie's clips in sequential order, fine tune their contents, and apply 
special effects to achieve desired results. For a brief description of a Story Board 
element, click it in the following figure. 

 

Notes: 

• You may assemble your movie in the Time Line instead of the Story Board. 

• The Story Board and Time Line are not separate items. They are simply 
different views of your work. Any clip added to the Story Board is also present 
on the Time Line and vice versa. 
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Related Topics 
Deleting Objects from the Story Board 
Dragging Audio Clips to the Story Board 
Dragging Video or Image Clips to the Story Board 
How to Use the Story Board 
Placing Special Effects on the Story Board 
Previewing Contents of the Story Board 
 
 
 
3.5 Add Special Effects 

WinDVD Creator 2 offers the following special effects: 

Transition Effects 

These special effects allow a gradual change between objects, such as fading from one 
scene to another scene. Suppose you insert a transition effect that gradually wipes the 
screen in a clockwise direction during the transition between two clips. In this scenario, 
the transition between the clips plays back similar to the following figure.  

 
First Clip Second Clip 

Titles 

These special effects let you add titles to your movie. WinDVD Creator 2 includes a set 
of title templates that you alter to define the title's text and the font, position, and color 
of that text. 

The title effects have a black background. You may also combine a title with a video or 
image clip to place the title over the clip. 

 
Related Topics 
Placing Special Effects on the Story Board 
Placing Special Effects on the Time Line 
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3.6 Authoring 
 
WinDVD Creator 2 lets you include an online table of contents in your movie so that 
viewers will be able to quickly jump to a specific location in that movie. To include this 
feature in your movie: 
 
3.6.a Add a theme. 
 
3.6.b Modify a chapter list to define which frames viewers will be able to jump to. 
 
3.6.c Create a video disk or video file to save the theme and its chapter list by burning to 
a CD or DVD 
 
3.6.d Author Preview lets you preview your movie with a selected Theme. 
 
 
3.6 .a. Add a theme 

Add a theme to your movie if you want viewers to be able to use an online table of 
contents to quickly jump to specific locations in your movie. 
 
WinDVD Creator 2 provides a set of themes that act as templates for the online table of 
contents you may include in your movie. Each theme includes a title and background 
graphic. When adding a theme, you may customize its background and modify the font, 
color, position, and size of the theme's title. 
 
To add a theme:  

1. Click  

2. Click on the  button located in the Media Libraries. The default WinDVD 

Creator 2 theme's will appear on the side pane. (There are different theme's categorized. 
To view each category, select the drop-down menu above the side pane and click. 
 

3. Scroll and double-click on the theme. 
 

Customize Theme's Background: 

Background Picture: 

1. Within the Authoring section, click on the  button. The Image Library will 
appear on the side pane with your images. 

2. Scroll and double-click on an image.  

This will change the current theme into the selected image. 
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Solid Color Background: 

1. Within the Image Library, there will be a Solid Color option. 

2. Check the box for a solid color background. 

3. Click on  button (after the Solid Color has been checked).  

4. Select the color, and it will change your background color. 

If you want to undo or redo a previous action at any time, click on: 

. The   button to undo an action 

. The  button to redo an action. 

WinDVD Creator 2 saves your theme. It also adds chapter marks ( , and so on) to 
each Story Board cell that contains an object. Chapter marks make up the chapter list 
that forms the basis of your movie's online table of contents. If you do not want your 
movie viewers to be able to jump to a particular object, remove that object's chapter 
mark as discussed in Modifying a Theme's Chapter List. 
 
Related Topic 
Modifying a Theme’s Chapter List 
 
 

 

3.6 .b. Modifying a Theme's Chapter List. 

WinDVD Creator 2 uses a theme's chapter list to create an online table of contents for 
your movie. 
 
A chapter list consists of a set of chapter marks ( , , and so on) that specify 
which frames viewers can quickly jump to while viewing your movie. By default, a 
theme's chapter list includes a chapter mark for each Story Board cell that contains an 
object. You modify a chapter list by deleting the chapter mark of each item you do not 
want included in your movie's online table of contents. 
 

To modify a chapter list:  

1. Click  
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2. In the Story Board, right-click an item you do not want included in the online 
table of contents. 

      Note: You cannot delete the first chapter. 

3. From the shortcut menu that appears, choose Delete Chapter Mark. 
If you accidentally delete an object's chapter mark, you can restore it by 
right-clicking the item again and choosing Add Chapter Mark from the 
shortcut menu that appears. 

Note: When modifying the Chapter list, you can not delete the first clip on the 
Story Board. 

 

 

3.6.c. Burning to a CD or DVD 

To burn your movie to a CD or DVD: 

1. Click  to open the Burning wizard. 

2. From the Format drop-down menu, select the format in which you want to save your 
movie. WinDVD Creator 2 supports several formats, each of which is best for certain 
uses as discussed in Output Format Guidelines. These formats include: DV Type I, 
DV Type II, AVI, MPEG1, or MPEG2. 

The format parameters WinDVD Creator displays at the bottom of the wizard depend 
on the format you select. 

3. From the TV System drop-down menu, select the appropriate video format (NTSC or 
PAL). 

4. In the Volume Name of Disc text box, enter the name you want Windows Explorer to 
use to refer to your movie on the disc. 

5. Click , to go to the next panel. 

6. Click Burn to Disc. 

7. Click  , to go to the next panel. 

8. From the Select Device drop-down menu, select the CD or DVD device to which you 
want to save your movie. 

9. From the Burning Speed drop-down menu, select the speed at which you want to 
write to the CD or DVD.Increasing the speed increases the chances of losing data. 
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10.Click  WinDVD Creator 2 displays status information while saving your 

work. You may stop the process at any time by clicking the  button. 

11. At the prompt that appears after your movie is copied, click OK. 

Note:   

• Some applications such as Media Player cannot play VCD or SVCD. You can 
use WinDVD or a similar player to play it.  

• -VR output format will not have Main Menu. 
 
Related Topic 
Saving to Your Computer 

 
 

 
3.6.d. Author Preview 

While authoring your movie, you will want to preview the Interactive Menu and movie 
on the Story Board. You can preview the Chapter Lists and the interactive buttons such 
as Play and etc. 

To preview (play back) your movie from the Story Board: 

1. Click . The Preview Window will be displayed. 

2. To browse through the Interactive Menu, use the controls given: 

 

3. To return to the Root Menu, Click . 

4. To close the Preview Window, Click .  

 

Note: If you want to pause the playback, click  After pausing the playback, 
you may resume it by clicking again. 
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Related Topic 
Modifying Chapter Lists 
 
 
3.7. Saving Your Work 

 

WinDVD Creator 2 includes a wizard that takes you step by step through the process of 
saving your work in the VCD, SVCD, DVD, or VR format. When saving your work, 
you have the option of 

• Burning your movie directly to a CD or DVD 

• Saving your movie to your computer's hard disk so you can burn it to a CD or 
DVD 

 

 

3.7.a. Burning to a CD or DVD 

To burn your movie to a CD or DVD: 

1. Click  to open the Burning wizard. 

2. From the Format drop-down menu, select the format in which you want to save your 
movie. WinDVD Creator 2 supports several formats, each of which is best for certain 
uses as discussed in Output Format Guidelines. These formats include: DV Type I, 
DV Type II, AVI, MPEG1, or MPEG2. 

The format parameters WinDVD Creator displays at the bottom of the wizard depend 
on the format you select. 

3. From the TV System drop-down menu, select the appropriate video format (NTSC or 
PAL). 

4. In the Volume Name of Disc text box, enter the name you want Windows Explorer to 
use to refer to your movie on the disc. 

5. Click , to go to the next panel. 

6. Click Burn to Disc. 

7. Click  , to go to the next panel. 

8. From the Select Device drop-down menu, select the CD or DVD device to which you 
want to save your movie. 
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9. From the Burning Speed drop-down menu, select the speed at which you want to 
write to the CD or DVD.Increasing the speed increases the chances of losing data. 

10.Click  WinDVD Creator 2 displays status information while saving your 

work. You may stop the process at any time by clicking the  button. 

11. At the prompt that appears after your movie is copied, click OK. 

Note:   

• Some applications such as Media Player cannot play VCD or SVCD. You can 
use WinDVD or a similar player to play it.  

• -VR output format will not have Main Menu. 
 
Related Topic 
Saving to Your Computer 

 

3.7.b. Saving to Your Computer 

To save your movie to your computer's hard disk: 

1. Click  to open the Burning wizard. 

2. From the Format drop-down menu, select the format in which you want to save 
your movie. WinDVD Creator 2 supports several formats, each of which is best 
for certain uses as discussed in Output Format Guidelines. These formats 
include: DV Type I, DV Type II, AVI, MPEG1, or MPEG2. The format 
parameters WinDVD Creator 2 displays at the bottom of the wizard depend on 
the format you select. 

3. From the TV System drop-down menu, select the appropriate video format 
(NTSC or PAL). 

4. In the Volume Name of Disc text box, enter a name for your work. This step is 
optional, but your work will be represented in Windows Explorer as a folder if 
you enter a name.  

Volume name is the name user could specify for that disc, later it could be used as 
reference. It will be shown in Windows Explorer as name for that disc. When it 
output to hard disk, it's not necessary. However it still could be used on folder name 
to hold the image. 
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5. Click  to go to the next panel. 

6. Click Write content to hard disk for later burning. By default, WinDVD 
Creator 2 saves your movie to the root directory of your hard disk. To save to a 
different location, browse to the desired location. 

7. Click  WinDVD Creator displays status information while saving 

your work. You may stop the process at any time by clicking . 

8.  At the prompt that appears after your movie is saved, click OK. 

Note: WinDVD Creator 2 will use the Volume Label as folder name to save the output 
image on to your hard drive, if the user selects the output image to hard drive. If you use 
the same Volume Label name to make another image on to the hard drive, it may 
overwrite the previous one. 

 
Related Topic 
Burning to a CD or DVD 
About the limitation of file storage 

 

 

3.8. Direct Record to Disc 

 

WinDVD Creator 2 allows the user to directly record their video, audio, or images onto 
a disc. Directly recording to the disc utilizes the user's time efficiently. The advantage 
WinDVD Creator 2 gives to the user is speeding the creation of their disc by minutes or 
hours compared to the normal disc creation time. 

Features available in Disc Manager: 

• Importing videos within the Video Library. 

• Capturing from external devices. i.e. camcorder or TV-Tuner. 

• Quick or Full format featured. 

• Authoring. 
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4. Making a Movie 

In WinDVD Creator 2, making a movie involves the following four processes: 

    
 

To learn about a particular process, click the appropriate link in the following list. 

• Capturing content 

• Editing 

• DVD-authoring 

• Saving your work to make a movie 

 
4.1 Working with Projects 

Use WinDVD Creator 2 projects to organize your work. A project includes 
information about the content you capture, your edits, and your final movie. Because 
WinDVD Creator 2 lets you save your work to a project, you can exit WinDVD 
Creator 2 and then later resume working on a movie without losing your changes. 

 
Related Topics 
Creating Projects 
Saving Projects 
Reopening a Project 

 
 
4.2 Capturing Content 

After creating a project, you need to capture the content that will serve as the 
building blocks of your movie. You capture content by performing one or more of the 
following tasks: 

• Recording video in WinDVD Creator 2. 

• Capturing still images in WinDVD Creator 2. 

• Recording audio in WinDVD Creator 2. 

• Importing video, audio, or image files created in WinProducer 2, WinCoder, 
or a similar application 
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WinDVD Creator 2 automatically adds the content it captures to one of the WinDVD 
Creator 2 Media Libraries. 

 
Related Topic 
What Can You Capture? 

 
4.2.a. Recording Video 

WinDVD Creator 2 can record video content from VCRs, USB cameras, game 
consoles, and other such sources attached to your computer. While recording video, 
WinDVD Creator 2 will also record any accompanying audio. 

 
 
4.2.b. Capturing Still Images 
 
WinDVD Creator 2 can capture still images from USB cameras, game consoles, and 
other such sources attached to your computer. The still images are captured in the 
BMP format. 

To capture still images for your movie: 

1. If your capturing device requires software, exit WinDVD Creator 2 and start the 
appropriate application. Then start WinDVD Creator 2.  

2. Click  

3. In the Capture pane, click the thumbnail of the desired recording device. 

  The control panel that appears includes buttons that provide the same functions as 
those found on your recording device. You may use the buttons to configure your 
device and control it while it is connected to your computer and is turned on. 

4. In the Preview window, click  to capture the desired image. 

5. Select either saving the screen capture into a image file or thumbnail. 

• WinDVD Creator 2 captures the image and automatically adds it to the Image 
Library. 
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4.2.c. Recording Audio 

You may add audio to your movie by using WinDVD Creator's Audio Manager to 

• Record audio from a CD so you can add background music or a voice-over to 
your movie 

• Record audio from a microphone so you can add a voice-over to your movie 

While recording audio in the Audio Manager, you may play back and watch your 
movie in the Preview Window to keep the recording and movie in sync. 

Audio clips of recordings made with the Audio Manager are automatically added to 
your movie and the Audio Library. 

 

4.2.c.1. Recording Audio from a CD 

You may use the Audio Manager to capture content for your movie by recording 
from a CD. This is useful if you want to use a CD's content as background music or a 
voice-over. While recording audio from a CD, you may synchronize the sound you 
are capturing with video and image clips in your movie. 

To record audio from a CD: 

1. Click  

2. Open the Audio Manager by doing one of the following: 

• On the Story Board, right-click a video or image clip you want the audio to 
accompany. Then choose Audio Manager from the short-cut menu that 
appears. 

• On the Time Line, right-click a video or image clip you want the audio to 
accompany. Then choose Audio Manager from the short-cut menu that 
appears. 

3.Click  to open the CD Recording Tool. 

4. From the first drop-down menu, select the CD drive from which you want to record 
sound. 

5. From the second drop-down menu, select the desired CD track. 

6. On the Story Board or Time Line, select the point in your movie at which the 
recording is to begin. You do so by playing back your movie in the Preview Area and 
then pausing at the desired point. 
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7. When you are ready to start recording, resume playing your movie in the Player 

Window. Then click . If you are synchronizing the movie and your recording, 

watch your movie so you can stay in sync. 

8. When you finish, click  to stop recording. WinDVD Creator 2 automatically 

adds the recording to the CD audio track and the Audio Library 

 
Related Topic 
Recording Audio from a Microphone 

 

 

4.2.c.2. Recording Audio from a Microphone 

You may use the Audio Manager to capture content for your movie by recording 
from a microphone attached to your computer. This is useful if you want to add a 
voice-over to your movie. While recording audio from a microphone, you may 
synchronize the sound you are capturing with video and image clips in your movie. 

To record audio from a microphone attached to your computer: 

1. Click  

2. Do one of the following: 

• In the Story Board, right-click a video or image clip you want the audio to 
accompany. Then choose Audio Manager from the short-cut menu that 
appears. 

• In the Time Line, right click a video or image clip you want the audio to 
accompany. Then choose Audio Manager from the short-cut menu that 
appears. 

3. In the Audio Manager, click  to open the Microphone Recording Tool 

4. On the Story Board or Time Line, select the point in your movie at which the 
recording is to begin. You do so by playing back your movie in the Preview Window 
and then pausing at the desired point. 

5. Click  

WinDVD Creator 2 begins a 3-2-1 countdown to give you time to prepare. At the end 
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of the countdown, resume playing back your movie in the Preview Window. Then 
watch your movie so you can stay in sync. 

6. When you finish, click  to stop recording. 

WinDVD Creator 2 automatically adds the recording to the microphone audio track 
and the Audio Library. 

 
Related Topic 
Recording Audio from a CD 

 

4.2.d. Importing Files 

You can import video, audio, or image files created in WinProducer 2, WinCoder, 
or a similar application. The files you import can be located on your computer or 
another computer connected to your network. WinDVD Creator 2 adds imported files 
as clips to the Media Libraries. For example, video clips are added to the Video 
Library and image clips are added to the Image Library. 

Import files using any of the following: 

• 3.2.a Drag-and-drop feature  

• 3.2.b Media Files command 

• 3.2.c Import button 

Notes:  

• WinDVD Creator 2 automatically imports the files it creates while capturing 
still images or recording video or audio. Therefore, you do not have to import 
such files. 

• Imported files are represented in the libraries as clips. While making a movie, 
you work with the clips rather than the original source files. 

• The audio and video portions of a video file are imported as a single video clip 
to keep the audio and video synchronized. 

WinDVD Creator 2 supports Windows compatible file as long as corresponding 
codec is installed in system. Divx is one of popular Windows compatible codec. Once 
DivX is installed on to the system, WinDVD Creator 2 could import DivX file. 
 
Related Topic 
What Can You Capture? 

4.2.d.1. Importing with Drag-and-Drop Feature 
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To import using the drag-and-drop feature: 

 
 
 
Notes: 

• WinDVD Creator 2 adds the imported files as clips to the appropriate library. 
For example, video clips are added to the Video Library and image clips are 
added to the Image Library. 

• The clips in the Media Libraries represent imported files. While making a 
movie, you work with the clips rather than the original source files. 

• The audio and video portions of a video file are imported as a single video clip 
to keep the audio and video synchronized. 

 
Related Topics 
Importing with a Command 
Importing with the Import Button 
What Can You Capture? 

 

4.2.d.2. Importing with the Media Files Command 

To import using the Media Files Command: 

5. From the Import menu, choose Media Files. The Import Media File dialog 
box appears. 

6. Browse to locate the files you want to import.  

7. Select the desired files.  To select multiple files, press Ctrl+Click or 
Shift+Click. You may import any combination of video, image, and audio 
files.  

8. Click Open.  If you are importing only one file, you may double-click the 
file name instead of clicking Open. 

 

Notes: 
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• WinDVD Creator 2 adds the imported files as clips to the appropriate Media 
Library. For example, video clips are added to the Video Library and image 
clips are added to the Image Library. 

• The clips in the Media Libraries represent imported files. While making a 
movie, you work with the clips rather than the original source files. 

• The audio and video portions of a video file are imported as a single video clip 
to keep the audio and video synchronized. 

 
Related Topics 
Dragging to Import Files 
Importing with the Import Button 
What Can You Capture? 
 
 
 
4.2.d.3. Importing with Import Button 

To import using the Import button: 

1. Do one of the following: 

• Click . Then click  in the Storage pane. 

• Click . Then click  in the Editing pane. 

The Import Media File dialog box appears. 

2. Browse to locate the files to import.  

3. Select the desired files. To select multiple files, press Ctrl+Click or Shift+Click, 
you may import any combination of video, image, and audio files.  

4. Click Open.  If you are importing only one file, you may double-click the file 
name instead of clicking Open. 

 

Notes: 

• The Import button is available only while you are capturing content or editing. 
It is not available when you are authoring or saving output. 

• WinDVD Creator 2 adds the imported files as clips to the appropriate Media 
Library. For example, video clips are added to the Video Library and image 
clips are added to the Image Library. 
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• The clips in the Media Libraries represent imported files. While making a 
movie, you work with the clips rather than the original source files. 

• The audio and video portions of a video file are imported as a single video clip 
to keep the audio and video synchronized. 

 
Related Topics 
Dragging to Import Files 
Importing with a Command 
What Can You Capture? 

 

4.3 Editing 

The editing process includes the following major tasks. You perform these operations 
in either the Story Board mode or Time Line mode. You may switch between the 
modes anytime during the editing process.  

• Breaking a video clip into smaller and more manageable scenes 

• Dragging clips so you can arrange the clips in the desired sequence on either 
the Story Board or Time Line 

• Trimming clips to remove unwanted sections 

• Deleting clips to remove them from your movie or project 

Note: The Story Board and Time Line editing modes provide different views of the 
same objects. Therefore, whatever edits you perform on an object in the Story Board 
mode also apply to that object in the Time Line. Conversely, whatever edits you 
perform on an object in the Time Line mode also apply to that object in the Story 
Board. Suppose that in the Story Board mode you drag a clip to the Story Board. If 
you later switch to the Time Line mode, notice that the Time Line includes the same 
clip. 

 

4.3.a. Breaking Up Video Clips 

Sometimes the video clips you record or import are too long to work with easily. 
For example, you might have captured 10 or 20 minutes of video from your camcorder 
into a single file. This would be much easier to work with if it were broken into smaller 
clips based on the natural scene breaks in the video. WinDVD Creator 2 can 
automatically create these scenes for you, saving a lot of time in the editing process. 

To automatically break up a video clip into smaller scenes: 
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1.Click   

2. If necessary, open the Video Library by clicking  in the Editing pane. 

3. In the Video Library, right-click the video clip you want to break up. You may need     
to scroll up or down in the Editing pane or resize it before the desired clip comes into 
view. 

4. Do one of the following: From the shortcut menu that appears, choose Show Video 
Scenes. 

5. Select either Auto Detect or By Time.  

• Choosing Auto Detect, you must set the Sensitivity at which it separates the 
scenes by. For example, the light factor between scenes or details of each image. 
From 1 being the lowest to 100 being the highest. 

• Choosing By Time will separate scenes into each clip depending on the time 
you set it too. 

6. Click  in the Editing pane. 

• WinDVD Creator 2 scans the video clip, looking for changes in the image from 
frame-to-frame. If it finds a significant change, which is common where the camera 
stopped and started, it breaks the clip into smaller clips (also called scenes) at the 
point.  

• WinDVD Creator 2 creates a new set of video clips in the Video Library. These 
clips are ordered from the start to the end of the original video clip. For example, 
WinDVD Creator 2 might break up a video clip into five scenes as shown in the figure 
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on the left.  

• No new files are created on the disk when you generate scene cuts. You may add 
any of generated scenes to your movie as you would any other clip. 

• You do not have to delete any unused scenes because WinDVD Creator 2 
automatically eliminates the generated scenes when you perform an action that causes 
WinDVD Creator 2 to leave the Video Library. If you want to later work with the scenes 
again, simply break up the clip again. 

 

4.3.b. Dragging clips 

To assemble your movie, place the clips you want on either the Story Board or Time 
Line. You do so by dragging the clips from a Media Library to the Story Board or 
Time Line. 

Before adding clips, you should be aware of the following: 

• On the Story Board, video and image clips are placed in an empty cell. Audio 
clips, however, are placed only on the thumbnail of a video clip, image clip, or 
title. 

• On the Time Line, video and image clips are placed in video tracks and audio 
clips are placed in audio tracks . You may place an unlimited number of clips 
in the Story Board or Time Line. 

You can undo or redo a previous action on the Story Board or TimeLine by 
either: 

• Pressing the undo or redo option in the Edit drop down menu.  

• Pressing CTRL+Z to undo an action or CTRL+Y to redo an action.  

Note:  

• The Story Board and Time Line are not separate items. They are simply 
different views of your work. Any clip added to the Story Board is also 
present on the Time Line and vice versa.  

• After you add a video or image clip to the Story Board or Time Line, 
WinDVD Creator 2 applies the used clip marker to the clip in its library. 

 

 
Related Topics 
Dragging Video or Image Clips to the Story Board  
Dragging Audio Clips to the Story Board 
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Dragging Video or Image Clips to the Time Line 
Dragging Audio Clips to the Time Line 

 

4.3.c. Trimming Clips 

Trim a clip to remove unwanted video or audio from the beginning or end. For 
example, you may have a 30-second video clip but only want to keep the middle 10 
seconds. In this case, trim off the first 10 and last 10 seconds. 

When you trim a clip, only the copy of the clip in the Story Board or Time Line 
is effected - the original in the Media Library is not changed. This feature lets you 
bring more than one copy of the same clip into your movie, and include different parts 
of the clip in different parts of that movie. 

In WinDVD Creator 2, the point at which a particular copy of a clip starts to play is 
called the "In Point" and the point where it ends is called the "Out Point." 

The two primary techniques for trimming clips are: 

• Trimming a video clip with the Video Cut Tool 

You may trim video clips with the Video Cut Tool. Although you can use the tool 
to trim a video clip that has sound, you cannot use the tool to trim audio clips. 

Use the Video Cut Tool to set the In and Out (start and stop) points of the clip. 
This technique lets you view the exact point at which you will set the In or Out 
point for the clip. 

• Dragging to trim a clip in the Time Line 

You may trim a video or audio clip by dragging the clip's left or right side. 

This method is a convenient way to make a fast adjustment to the length of the 
clip, but does not have the advantage of viewing the actual trim point of a video 
clip while you are dragging. 

Note: When you trim a video clip that has sound, WinDVD Creator 2 trims both the 
video and audio portions together to keep them synchronized. 

 

Trimming a Clip with the Video Cut Tool 

The Video Cut Tool lets you trim video clips. If a video clip includes sound, the tool 
will trim the audio portion at the same time it trims the video. 

Trimming a clip with the Video Cut Tool is the process of setting the In and Out (start 
and stop) points for the clip. Setting the In Point eliminates any video or audio that 
comes before that point. Similarly, setting the Out Point in the clip eliminates any 
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video or audio that would normally be beyond that point in the clip.  

To trim a clip with the Video Cut Tool: 

1. Click  

2. In the Time Line or Story Board, select the clip you want to trim. Then right-click, 

You may trim a clip with the Video Cut Tool in either the Story Board mode or 
Time Line mode. In both modes, you will be able to view the effects of your 
changes in the Video Manager. However, trimming it in the Time Line mode gives 
you the advantage of viewing the clip's changes on the Time Line as well. 

3. From the shortcut menu that appears, choose Video Manger to open the Video Cut 
Tool. 

4. Trim the clip by using the In Point Trimmer and Out Point Trimmer; 

As summarized in the following figure, sliding the In Point Trimmer trims frames 
from the clip's beginning and Sliding the Out Point Trimmer trims frames from the 
clip's ending. 

 

Dragging to Trim a Clip in the Time Line 

Dragging one end of a clip is a quick method for removing frames from a video or 
audio clip's beginning or ending. 

To drag a clip to trim it: 

1.Click . 

2. If necessary, click . to open the Time Line. 

3. In the Time Line, select the clip you want to trim. 

4. At the end you want to trim, position the mouse until the pointer becomes a 
.Then drag the clip's end in or out to trim the clip. 
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4.3.d. Deleting Clips 

WinDVD Creator 2 lets you 

• Delete clips from a Media Library 

• Delete clips from the Story Board 

• Delete clips from the Time Line 

Notes:  

• Deleting a clip does not delete the original file. To delete a file, use the 
standard Windows techniques from the desktop or Windows Explorer. 

• You cannot delete a clip while it is playing in the Preview Window. 
 

4.3.d.1. Deleting Clips from a Library 

To delete clips from a Media Library: 

1. Open the library that includes the clip you want to delete. To do so, perform 
one of the following operations : 

• Click . In the Storage pane, click the tab of the library 

containing the clip you want to delete. 

• Click In the Storage pane, click the tab of the library 

containing the clip you want to delete. 

2. Select the unwanted clip. 

3. Perform one of the following: 

• Right-click. From the shortcut menu that appears, choose Delete. 

• Press the Delete key. 

• Click the Trash Can icon, which is located in the lower-right corner of 
the Main Window. 

Notes: 

• Deleting a clip does not delete the original file. To delete a file, use the 
standard Windows techniques from the desktop or Windows Explorer. 

• You cannot delete a clip while it is playing in the Preview Window. 

• You cannot delete a clip if the clip or one of its scenes is currently included in 
the Story Board and Time Line. 
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• You cannot delete a clip representing a generated scene from the Video 
Library. WinDVD Creator 2 will automatically eliminate such clips when you 
perform an action that causes WinDVD Creator 2 to leave the Video Library. 

 
Related Topic 
Deleting Objects from the Story Board 
Deleting Objects from the Time Line 

 
 
 
 
4.3.d.2. Deleting Objects from the Story Board 

 

To delete an unwanted clip or special effect from the Story Board: 

1. Click . 

2. If necessary, switch to the Story Board mode by clicking  

3. In the Story Board, do one of the following: 

• Delete an unwanted object by using a shortcut menu, To do so, right-click the 
unwanted object and choose Delete from the shortcut menu that appears. 

• Delete an unwanted object by selecting it and then pressing the Delete key. 

• Delete an unwanted object by selecting it and then clicking the trash can icon 

, which is located in the lower right of the main window. 

• Remove a title without deleting the clip in which the title appears. To do so, 
right-click the object that includes the title, and then choose Delete 
Title\Overlay from the shortcut menu that appears. 

When you delete all the objects of a cell in the Story Board, WinDVD Creator 
2 moves all other objects in a Story Board cell one cell over to the left. 

Notes: 

• Deleting a clip from the Story Board does not effect the original clip in a 
Media Library. 

• Deleting a clip from the Story Board also deletes any title defined for that clip. 

• After you delete a video or image clip from the Story Board, WinDVD Creator 
2 removes the used clip marker from that clip in its library. 
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• The Story Board and Time Line are not separate items. They are simply 
different views of your work. Any object deleted from the Story Board will no 
longer be displayed in the Time Line and vice versa. 

 

Related Topics 
Deleting Objects from the Time Line 
 
 
4.3.d.3. Deleting Objects from the Time Line 

 

To delete an unwanted clip or special effect from the Time Line: 

1. Click . 

2. If necessary, switch to the Time Line mode by clicking  

3. In the Time Line, select the unwanted object. 

4. Do one of the following: 

• Right-click and choose Delete from the shortcut menu that appears. 

• Press the Delete key. 

• Click the trash can icon , which is located in the lower right of the main 

window. 
 
 
 
4.4 Add Special Effects 

WinDVD Creator 2 offers the following special effects: 

Transition Effects 

These special effects allow a gradual change between objects, such as fading from one 
scene to another scene. Suppose you insert a transition effect that gradually wipes the 
screen in a clockwise direction during the transition between two clips. In this scenario, 
the transition between the clips plays back similar to the following figure.  

 
First Clip Second Clip 
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Titles 

These special effects let you add titles to your movie. WinDVD Creator 2 includes a set 
of title templates that you alter to define the title's text and the font, position, and color 
of that text. 

The title effects have a black background. You may also combine a title with a video or 
image clip to place the title over the clip. 

 
Related Topics 
Placing Special Effects on the Story Board 
Placing Special Effects on the Time Line 
 
 

 
4.5 Authoring 
 
WinDVD Creator 2 lets you include an online table of contents in your movie so that 
viewers will be able to quickly jump to a specific location in that movie. To include this 
feature in your movie: 
 
Add a theme. 
 
Modify a chapter list to define which frames viewers will be able to jump to. 
 
Create a video disk or video file to save the theme and its chapter list by burning to a 
CD or DVD 
 
Author Preview lets you preview your movie with a selected Theme. 
 
 
4.5.a. Add a theme 

Add a theme to your movie if you want viewers to be able to use an online table of 
contents to quickly jump to specific locations in your movie. 
 
WinDVD Creator 2 provides a set of themes that act as templates for the online table of 
contents you may include in your movie. Each theme includes a title and background 
graphic. When adding a theme, you may customize its background and modify the font, 
color, position, and size of the theme's title. 
 
To add a theme:  

1. Click  
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2. Click on the  button located in the Media Libraries. The default WinDVD 

Creator 2 theme's will appear on the side pane. (There are different theme's categorized. 
To view each category, select the drop-down menu above the side pane and click. 
 

3. Scroll and double-click on the theme. 
 

Customize Theme's Background: 

Background Picture: 

1. Within the Authoring section, click on the  button. The Image Library will 
appear on the side pane with your images. 

2. Scroll and double-click on an image.  

This will change the current theme into the selected image. 

 

Solid Color Background: 

1. Within the Image Library, there will be a Solid Color option. 

2. Check the box for a solid color background. 

3. Click on  button (after the Solid Color has been checked).  

4. Select the color, and it will change your background color. 

If you want to undo or redo a previous action at any time, click on: 

. The   button to undo an action 

. The  button to redo an action. 

WinDVD Creator 2 saves your theme. It also adds chapter marks ( , and so on) to 
each Story Board cell that contains an object. Chapter marks make up the chapter list 
that forms the basis of your movie's online table of contents. If you do not want your 
movie viewers to be able to jump to a particular object, remove that object's chapter 
mark as discussed in Modifying a Theme's Chapter List. 
 
Related Topic 
Modifying a Theme’s Chapter List 
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4.5.b. Modifying a Theme's Chapter List. 

WinDVD Creator 2 uses a theme's chapter list to create an online table of contents for 
your movie. 
 
A chapter list consists of a set of chapter marks ( , , and so on) that specify 
which frames viewers can quickly jump to while viewing your movie. By default, a 
theme's chapter list includes a chapter mark for each Story Board cell that contains an 
object. You modify a chapter list by deleting the chapter mark of each item you do not 
want included in your movie's online table of contents. 
 

To modify a chapter list:  

4. Click  

5. In the Story Board, right-click an item you do not want included in the online 
table of contents. 

      Note: You cannot delete the first chapter. 

6. From the shortcut menu that appears, choose Delete Chapter Mark. 
If you accidentally delete an object's chapter mark, you can restore it by 
right-clicking the item again and choosing Add Chapter Mark from the 
shortcut menu that appears. 

Note: When modifying the Chapter list, you can not delete the first clip on the 
Story Board. 

 

 

4.5.c. Burning to a CD or DVD 

To burn your movie to a CD or DVD: 

1. Click  to open the Burning wizard. 

2. From the Format drop-down menu, select the format in which you want to save your 
movie. WinDVD Creator 2 supports several formats, each of which is best for certain 
uses as discussed in Output Format Guidelines. These formats include: DV Type I, 
DV Type II, AVI, MPEG1, or MPEG2. 

The format parameters WinDVD Creator displays at the bottom of the wizard depend 
on the format you select. 
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3. From the TV System drop-down menu, select the appropriate video format (NTSC or 
PAL). 

4. In the Volume Name of Disc text box, enter the name you want Windows Explorer to 
use to refer to your movie on the disc. 

5. Click , to go to the next panel. 

6. Click Burn to Disc. 

7. Click  , to go to the next panel. 

8. From the Select Device drop-down menu, select the CD or DVD device to which you 
want to save your movie. 

9. From the Burning Speed drop-down menu, select the speed at which you want to 
write to the CD or DVD.Increasing the speed increases the chances of losing data. 

10.Click  WinDVD Creator 2 displays status information while saving your 

work. You may stop the process at any time by clicking the  button. 

11. At the prompt that appears after your movie is copied, click OK. 

Note:   

• Some applications such as Media Player cannot play VCD or SVCD. You can 
use WinDVD or a similar player to play it.  

• -VR output format will not have Main Menu. 
 
Related Topic 
Saving to Your Computer 

 

 
4.5.d. Author Preview 

While authoring your movie, you will want to preview the Interactive Menu and movie 
on the Story Board. You can preview the Chapter Lists and the interactive buttons such 
as Play and etc. 

To preview (play back) your movie from the Story Board: 

1. Click . The Preview Window will be displayed. 

2. To browse through the Interactive Menu, use the controls given: 
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3. To return to the Root Menu, Click . 

4. To close the Preview Window, Click .  

 

Note: If you want to pause the playback, click  After pausing the playback, 
you may resume it by clicking again. 
 
Related Topic 
Modifying Chapter Lists 

 

4.6 Opening the Disc Manager 

Disc Manager lets you place video and image content directly onto your DVD. The 
advantage of using Disc Manager is that it allows you to quickly make a DVD 
without putting any titles or effects onto your media content, and it automatically sets 
up chapters with a default theme. Use the Disc Manager to directly edit the content of 
your DVD without having to render it on the hard drive.  

To open the Disc Manager: 

1. Click . 

2. The Disc Manager Panel will open up with four different functions: 

• Video Library:  
The Video Library is where you can import your video files.  

• Capture:  
WinDVD Creator 2 allows you to capture video files using a DV device, 
Capture Card, or Web Camera.  

• Tools:  
In the Tools section, you can choose to either defragment or format your 
DVD.  
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• Authoring: 
Authoring lets you choose the theme you want to set for your chapter menu.  

 
4.7 Saving Your Work 
 

WinDVD Creator 2 includes a wizard that takes you step by step through the process 
of saving your work in the VCD, SVCD, DVD, or VR format.. When saving your 
work, you have the option of 

• Burning your movie directly to a CD or DVD 

• Saving your movie to your computer's hard disk so you can burn it to a CD or 
DVD later 

 

4.7.a. Burning to a CD or DVD 

To burn your movie to a CD or DVD: 

1. Click  to open the Burning wizard. 

2. From the Format drop-down menu, select the format in which you want to save your 
movie. WinDVD Creator 2 supports several formats, each of which is best for certain 
uses as discussed in Output Format Guidelines. These formats include: DV Type I, 
DV Type II, AVI, MPEG1, or MPEG2. 

The format parameters WinDVD Creator displays at the bottom of the wizard depend 
on the format you select. 

3. From the TV System drop-down menu, select the appropriate video format (NTSC or 
PAL). 

4. In the Volume Name of Disc text box, enter the name you want Windows Explorer to 
use to refer to your movie on the disc. 

5. Click , to go to the next panel. 

6. Click Burn to Disc. 

7. Click  , to go to the next panel. 

8. From the Select Device drop-down menu, select the CD or DVD device to which you 
want to save your movie. 

9. From the Burning Speed drop-down menu, select the speed at which you want to 
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write to the CD or DVD.Increasing the speed increases the chances of losing data. 

10.Click  WinDVD Creator 2 displays status information while saving your 

work. You may stop the process at any time by clicking the  button. 

11. At the prompt that appears after your movie is copied, click OK. 

Note:   

• Some applications such as Media Player cannot play VCD or SVCD. You can 
use WinDVD or a similar player to play it.  

• -VR output format will not have Main Menu. 

 

 

4.7.b. Saving to Your Computer 

To save your movie to your computer's hard disk: 

9. Click  to open the Burning wizard. 

10. From the Format drop-down menu, select the format in which you want to save 
your movie. WinDVD Creator 2 supports several formats, each of which is best 
for certain uses as discussed in Output Format Guidelines. These formats 
include: DV Type I, DV Type II, AVI, MPEG1, or MPEG2. The format 
parameters WinDVD Creator 2 displays at the bottom of the wizard depend on 
the format you select. 

11. From the TV System drop-down menu, select the appropriate video format 
(NTSC or PAL). 

12. In the Volume Name of Disc text box, enter a name for your work. This step is 
optional, but your work will be represented in Windows Explorer as a folder if 
you enter a name.  

Volume name is the name user could specify for that disc, later it could be used as 
reference. It will be shown in Windows Explorer as name for that disc. When it 
output to hard disk, it's not necessary. However it still could be used on folder name 
to hold the image. 

13. Click  to go to the next panel. 

14. Click Write content to hard disk for later burning. By default, WinDVD 
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Creator 2 saves your movie to the root directory of your hard disk. To save to a 
different location, browse to the desired location. 

15. Click  WinDVD Creator displays status information while saving 

your work. You may stop the process at any time by clicking . 

16.  At the prompt that appears after your movie is saved, click OK. 

Note: WinDVD Creator 2 will use the Volume Label as folder name to save the output 
image on to your hard drive, if the user selects the output image to hard drive. If you use 
the same Volume Label name to make another image on to the hard drive, it may 
overwrite the previous one. 

 
Related Topic 
Burning to a CD or DVD 
About the limitation of file storage 
 

4.8 Exiting WinDVD Creator 2 

To exit WinDVD Creator 2, do one of the followings: 

• From the Project menu, choose Exit  

• Click  in the application control menu, which is located in the upper-right 

of the WinDVD Creator 2 main window. 

If there are unsaved changes, WinDVD Creator 2 prompts you to save your work to a 
project. 

• To save your work to your current project before exiting WinDVD Creator 2, 
click Yes.  

• To save your work for the first time to a project, click Yes. After WinDVD 
Creator 2 prompts you to save your work to a project, enter a project name and 
then click Save. WinDVD Creator 2 saves your work in the specified project 
and then exits. 

• To not save recent changes before exiting WinDVD Creator 2, click No. 

• To remain in WinDVD Creator 2 without saving recent changes, click Cancel. 

 

 


